Coastal Inlets Research Program

GenCade Version 1 Quick-Start Guide: How to Start a Successful GenCade Project

Sophie Munger and Ashley E. Frey

March 2015

Approved for public release; distribution is unlimited.
The US Army Engineer Research and Development Center (ERDC) solves the nation’s toughest engineering and environmental challenges. ERDC develops innovative solutions in civil and military engineering, geospatial sciences, water resources, and environmental sciences for the Army, the Department of Defense, civilian agencies, and our nation’s public good. Find out more at [www.erdc.usace.army.mil](http://www.erdc.usace.army.mil).

To search for other technical reports published by ERDC, visit the ERDC online library at [http://acwc.sdp.sirs.net/client/default](http://acwc.sdp.sirs.net/client/default).
GenCade Version 1 Quick-Start Guide: How to Start a Successful GenCade Project

Sophie Munger
Blue Science Consultants, LLC
3000 Lillard Drive, Ste 258
Davis, CA 95618-4802

Ashley E. Frey
Coastal and Hydraulics Laboratory
U.S. Army Engineer Research and Development Center
3909 Halls Ferry Rd
Vicksburg, MS 39180-6199

Final report
Approved for public release; distribution is unlimited.
Abstract

This special report is a condensed version of previous technical reports describing the shoreline change model GenCade. It is meant to provide new and prospective users of GenCade a starting point to learn the model. While no new topics are presented, important information which would otherwise be distributed among several publications is conveniently grouped in one short document. The first part of the report describes the basic features of the model and its suitability to a range of applications to help prospective users decide if GenCade is the right tool for a specific project. The second part of the report is a quick-start guide with step-by-step instruction on how to build a GenCade project. Each topic presented in this publication is accompanied by a list of references that provide more in-depth information.
Contents

Abstract .......................................................................................................................................................... ii

Figures and Tables ......................................................................................................................................... v

Preface ............................................................................................................................................................ vi

1 Introduction ............................................................................................................................................ 1

2 Model Suitability, Overview, and Data Needs ...................................................................................... 2
   2.1 What is GenCade? ................................................................................................................................. 2
   2.2 Is GenCade the right tool? ....................................................................................................................... 3
   2.3 What is needed to get started? ................................................................................................................ 4
   2.4 GenCade work flow ................................................................................................................................. 6
       2.4.1 Initialization .................................................................................................................................. 6
       2.4.2 Data collection ................................................................................................................................. 6
       2.4.3 Model setup .................................................................................................................................. 7
       2.4.4 Calibration, validation, sensitivity testing ...................................................................................... 8
       2.4.5 Production runs ............................................................................................................................... 8
       2.4.6 Analysis and interpretation of the results ...................................................................................... 8

3 Quick-Start Guide .................................................................................................................................. 9
   3.1 Create a workspace ................................................................................................................................ 9
       3.1.1 Set global project and units ....................................................................................................... 10
       3.1.2 Locate GenCade executable .................................................................................................. 10
       3.1.3 Save project ................................................................................................................................. 10
   3.2 Importing project-related imagery, CAD, and ESRI shape files ......................................................11
       3.2.1 Import imagery ............................................................................................................................ 11
       3.2.2 Import CAD and ESRI shape files ............................................................................................. 11
   3.3 Create a GenCade initial shoreline .................................................................................................... 11
       3.3.1 Create the *.cst file .................................................................................................................. 12
       3.3.2 Load the file into SMS .............................................................................................................. 12
       3.3.3 Define coverage as GenCade .................................................................................................. 13
       3.3.4 Define arc as initial shoreline ................................................................................................. 13
       3.3.5 Inspect the shoreline for accuracy ........................................................................................... 13
       3.3.6 Using other data formats ........................................................................................................ 14
   3.4 Is a regional contour needed? Creating a regional contour ........................................................... 14
       3.4.1 Use a shoreline or contour ...................................................................................................... 14
       3.4.2 Define coverage and attributes .................................................................................................. 15
       3.4.3 Save map files ......................................................................................................................... 15
       3.4.4 Merge coverages ......................................................................................................................... 15
   3.5 Processing and inputting wave data ..................................................................................................16
       3.5.1 Enter location of wave gauge(s) ............................................................................................... 17
       3.5.2 Load wave data ......................................................................................................................... 18
3.6 Adding structures and engineering activities

3.6.1 Create inlet

3.6.2 Jetties

3.6.3 Other structures and engineering activities

3.7 Creating a GenCade grid

3.7.1 Create grid frame

3.7.2 Define cell size

3.7.3 Convert map to 1D grid

3.7.4 Making modifications to the arcs

3.7.5 Save control file

3.7.6 Note on the GenCade menu

3.8 Control parameters and execution of the model

3.8.1 Model setup

3.8.2 Beach setup

3.8.3 Seaward boundary condition (BC)

3.8.4 Lateral BC

3.8.5 Run GenCade

3.9 How to view and export the results

3.9.1 Visualizing output

3.9.2 Making plots

3.9.3 Visualizing inlet shoal volumes

3.9.4 Export data

3.9.5 Print file

3.10 Calibrate the model

3.10.1 Comparison of measured and observed final shorelines

3.10.2 Calibration

3.10.3 Calibration of shoreline near inlets

3.10.4 Calibration of shoreline near structures

3.10.5 Regional contour

3.10.6 Sources and sinks

3.10.7 Validation

3.11 Production runs and final product

4 Summary and Conclusions

References

Appendix A: File Descriptions

Report Documentation Page
Figures and Tables

Figures

Figure 1. The SMS graphical interface and common nomenclature. ..................................................... 9
Figure 2. Coastline file (*.cst). .................................................................................................................... 12
Figure 3. Wave angle convention in SMS. A) Meteorological: direction clockwise from true North to the direction the waves are coming; B) Oceanographic: direction clockwise from true North to the direction the waves are going; C) Cartesian: direction counterclockwise from the horizontal to the direction the waves are going; D) Shore-normal (grid-normal): angle between the right angle from the x-axis and the direction waves are coming. A positive angle means the waves are traveling in the positive x-axis direction. .................................... 17
Figure 4. GenCade grid orientation convention. ...................................................................................... 19

Tables

Table 1. SMS Dynamic Tools...................................................................................................................... 13
Table A1. SMS Specific Files...................................................................................................................... 32
Table A2. GenCade input file names, descriptions, and units. .............................................................. 32
Table A3. GenCade output file names, descriptions, and units............................................................. 33
Preface

This work was performed by the Coastal Inlets Research Program (CIRP), which is funded by the Operation and Maintenance (O&M) Navigation business line of the Headquarters, U.S. Army Corps of Engineers (HQUSACE). The CIRP is administered for Headquarters by the U.S. Army Engineer Research and Development Center (ERDC), Coastal and Hydraulics Laboratory (CHL), Vicksburg, MS, under the Navigation Program of HQUSACE. Jeffrey A. McKee is HQUSACE Navigation Business Line Manager overseeing the CIRP. Jeff Lillycrop, CHL, is the ERDC Technical Director for Navigation, and Charles E. Wiggins is the ERDC Associate Technical Director for Navigation. Dr. Julie Rosati, CHL, is the CIRP Program Manager.

The CIRP has developed GenCade, a one-dimensional (1D) numerical model that calculates shoreline change and wave-induced longshore sand transport. This report provides new and prospective users a starting point for learning GenCade.

This report was prepared by Sophie Munger of Blue Science Consultants, LLC, and administered through Texas A&M University–Corpus Christi, and by Ashley E. Frey of the Coastal Engineering Branch (CEB), ERDC-CHL. At the time of publication, Tanya M. Beck was Chief of CEB; Dr. Jackie Pettway was Chief of the Navigation Division (HN), CHL. Ken Connell of Golder Associates and Dr. David King of the Coastal Processes Branch, CHL, reviewed this report. Dr. Kevin Barry and José E. Sánchez were the Deputy Director and Director of CHL, respectively, during the study and preparation of this report.

COL Jeffrey R. Eckstein was ERDC Commander. Dr. Jeffery P. Holland was ERDC Director.
1 Introduction

GenCade is a numerical model developed by the Coastal Inlets Research Program (CIRP). GenCade is a one-line, shoreline change model that was developed to combine and improve upon the capabilities of previous shoreline response models Cascade (Larson et al. 2003; Larson and Kraus 2003; Larson et al. 2006; Connell and Kraus 2006; Larson et al. 2007) and GENESIS (Hanson 1987; Hanson and Kraus 1989; Gravens et al. 1991; Hanson et al. 2006). GenCade was developed to operate within the Surface-Water Modeling System (SMS) platform. The SMS interface (version 11.1 and later) provides a powerful advantage over previous interfaces since it allows the user to construct a project directly over satellite imagery with readily available georeferenced data instead of using the traditional cell number and y-position grid system. Although the new interface provides numerous advantages, the more complex interface can be intimidating to some longtime users of GENESIS. To date, several varieties of GenCade documentation are available to new and experienced users, including technical reports (TR) (Frey et al. 2012a; Frey et al. 2014), wiki-pages (cirpwiki.info/wiki/GenCade), and webinar recordings (available on YouTube with full URL listings on cirp.usace.army.mil/techtransfer/webinars/16Oct2012-webinar.php). In an effort to facilitate the self-teaching of GenCade, shorter, more concise documents with a broader distribution in the form of a quick-start guide as well as a series of video tutorials are in development and will be posted on the CIRP webpage. This document is intended for new users and anyone interested in assessing the suitability of GenCade for their project. The first part of this special report (SR) answers general questions about GenCade capabilities and applicability. The second part of the report is a quick-start guide that provides step-by-step instruction on how to produce a simple GenCade project. All topics discussed are supplemented with precise references if the reader wishes to learn more about a certain aspect of the model.

This report is organized into four chapters:

- Chapter 1 presents an overview of GenCade and the purpose of this report.
- Chapter 2 describes the model and its suitability for specific projects.
- Chapter 3 provides a quick-start guide.
- Chapter 4 summarizes the report.
2 Model Suitability, Overview, and Data Needs

2.1 What is GenCade?

GenCade is a 1D numerical model developed by the CIRP that calculates shoreline change based on differential wave-driven longshore sand transport rates. The model has the capability to represent sand transport, accretion, and erosion at inlets and beaches and can include engineering activities such as beach fills and dredging and coastal structures such as jetties, seawalls, and groins. It outputs the shoreline position over time, the alongshore sediment transport rates, and the sand volume evolution of inlet shoals. It is run within the Surface-water Modeling System (SMS) 11.1 (and subsequent versions) and can be applied for short-term (multiyear) engineering design scale projects or for long-term (multidecadal) regional scale studies. A few examples of questions that can be answered by a GenCade project are as follows:

- What are the long-term shoreline and volumetric responses of a particular structure or group of structures on an adjacent beach?
- What are the long-term shoreline and volumetric responses of dredging, sand bypassing, or beach fill projects on an adjacent beach?
- How long does a beach fill provide coastal protection? How long is its lifespan?
- Where are the optimal sand mining and placement locations within the littoral cell? When are the optimal sand mining and placement time frames and intervals?
- What are the effects of multiple dredging intervals on the volume of an inlet’s ebb shoal and adjacent beaches? What is the optimal annual dredging volume to retain inlet volume equilibrium?
- What are the net/gross transport rates? Where are the sand transport nodal points and reversals?
- What is the cumulative impact of several engineering activities to the regional sediment budget in a multi-inlet system?

1 for the remainder of this SR. Examples of model applications and recently completed projects can be found in these published reports and technical notes (TN) for Onslow Bay, NC (Frey et al. 2012b), St. Johns County, FL (Beck and Legault 2012), and Sargent Beach and Matagorda Peninsula, TX (Thomas and Dunkin 2012; Rosati et al. 2013). All of the documentation mentioned is available for download from the CIRP website (cirp.usace.army.mil).

2.2 Is GenCade the right tool?

GenCade is a one-line model which means that the shoreline (which is the line referenced in the name one-line) moves landward or seaward while preserving the same beach profile shape. Intrinsic assumptions for this type of model will restrict the optimal use of the model, and the modeler should evaluate the suitability of GenCade for a particular study site. A list of the general assumptions upon which all one-line models are based is presented in Section 2.1 of GenCade Report 1. A more in-depth discussion of the assumptions and when they can be violated is presented in the second chapter of the Recommendations and Requirements for GenCade Simulations TR (Frey et al. 2014), hereafter referred to as GenCade Report 2.

In general, the study site should satisfy the following conditions:

1. The beach profile of the project site should conform to an equilibrium profile shape and remain constant in form. Seasonal variations can be expected, but the cross-shore fluctuations should average out over multiple years.

2. Wave-driven longshore transport is the primary driver of the long-term shoreline change. GenCade is based on the Coastal Engineering Research Center (CERC) formula, which is a surfzone-wide (total) longshore transport equation (CERC 1973; Rosati et al. 2002), and detailed structure of the nearshore circulation is ignored. Analysis of historical shoreline position plots should show a consistent trend in shoreline change, and dramatic changes to the trend should have a reasonable explanation (overwash events, inlet opening, shoal collapse, etc.). The internal wave model will assume parallel offshore contours; if the bathymetry is complex (large tidal delta, underwater headland, etc.), the use of an external wave model might be necessary to correctly reproduce the trends in sand transport.

3. There should be enough erodible material available for transport. The bottom of the area of active transport, from dune to depth of closure
should consist mostly of uniform sand. However, strategies exist to account for limited known hard bottom or consolidated peat/mud material (see example at Sargent Beach and Matagorda Peninsula, TX, in Thomas and Dunkin (2012) and Rosati et al. 2013).

2.3 What is needed to get started?

GenCade can be executed on a standard desktop or laptop computer (with Microsoft Windows XP, Windows Vista, Windows 7, or Windows 8) and will typically complete a simulation within 5 to 15 minutes depending on the number of years in the simulation, the complexity of the model, and the power of computer processor. GenCade runs within the SMS 11.1 interface (or subsequent versions). It provides a real-world environment to create and manage a GenCade grid and to view and export the results. SMS licenses are provided for USACE personnel and can be acquired through Aquaveo, LLC, for others (www.aquaveo.com).

The absolute minimum data requirements for the execution of GenCade follow:

- Initial shoreline
- Wave data (significant wave height, period, and direction; location and depth of each wave gauge)
- Grid information
  - Grid origin
  - Grid orientation
  - Number of cells in grid
  - Grid cell sizes
- Beach and sediment information
  - Median grain size, D50
  - Berm height
  - Depth of closure
- Model simulation information
- Time-step
  - Calibration parameters
* K1
* K2
* ISMOOTH

- Save output frequency
- Boundary condition (BC) specification

* Pinned BC
* Moving BC
  - Rate
  - Shoreline change rate period
* Gated BC
  - Groin location, length

Project-specific requirements follow:

- Structures
  - Groins (position, length, permeability, water depth at tip)
  - Detached breakwaters (depths, choice of wave transmission equation, wave transmission coefficient, breakwater geometry)
  - Seawalls (position)

- Inlets
  - Jetty (length, permeability, bypassing coefficient)
  - Attachment bars (location, width)
  - Initial and equilibrium shoal volumes (Attachment bars (2), bypassing bars (2), flood shoal, ebb shoal)

- Engineering operations
  - Dredging (volume, time period, mined shoal type)
  - Sources/sinks (bypassing rate)
  - Beach fill (location, time period, added berm width)

Although not necessary for the execution of the model the following datasets are strongly recommended:
- At least three, high-quality shoreline surveys several years apart but surveyed over the same season of the year if possible. One will serve as initial shoreline while the other two will be used as reference shorelines for calibration and validation.
- All available historical shorelines and/or offshore contours to construct the regional contour and improve familiarity with the study site.
- CAD Drawings or Shapefiles of project components.
- Good-quality, georeferenced aerial photographs or satellite imagery taken as close as possible to the initial shoreline survey date.
- Historical photographs will also be useful for site familiarization.
- When available, previously calculated sediment budget studies for validation and beach profiles.

Section 4.1 of GenCade Report 1 and Section 3.1 of the GenCade Report 2 explain in more detail the input files and format required for GenCade.

### 2.4 GenCade work flow

This section will provide new users with an overview of the sequence of standard steps involved in a typical GenCade project. A more in-depth discussion on the fundamental work-flow steps is presented in Section 4.1 of GenCade Report 2. Here is a brief summary of the suggested steps.

#### 2.4.1 Initialization

At the start of the project, the modeler should become familiar with the study site by reviewing literature and data, discussing the site with experts and making a site visit if possible. In addition, it is good practice at the beginning of a project to establish the layout of the final documentation. Having a project document right from the start will facilitate the early writing of certain portions of the project that could otherwise be forgotten, such as details on the input data processing and site history.

#### 2.4.2 Data collection

The next step is to collect the required data listed in Section 2.3. It is a good idea to keep all the data together for easy access and to keep a document with an inventory of all engineering activities, structures, inlet details, etc. Keeping a log of the observed erosion and accretion rates, transport direction, etc., will be very useful during the calibration process.
2.4.3 Model setup

2.4.3.1 The conceptual model

As detailed in Section 3, the user will import georeferenced data into the SMS Project Explorer. In the Project Explorer, the data will be grouped under a folder or coverage. All the project-specific data such as the shoreline, wave gauge, structures, and grid will be added to a single coverage called the conceptual model. The term conceptual model is used by Aquaveo, LLC, the developers of the model interface. In this context, the conceptual model does not refer to a simplified representation of the site to be modeled. The term refers to a georeferenced representation of the model build with feature objects made of points and arcs that represent the shoreline, structures, wave gauge, etc. The conceptual model is constructed independently of the numerical model (GenCade) or numerical grid. Once the conceptual model objects are defined, the user will define a grid frame, and all the data within the conceptual model will be converted to a 1D grid system. The objects will be assigned the proper cell number and $y$-position and will be saved to a control file (*.gen) that is used as input for the GenCade executable. The user can always go back to the conceptual model, make modifications, and regenerate the 1D grid.

The SMS conceptual model is further discussed in Section 4.2 of GenCade Report 1 and at www.xmswiki.com/xms/SMS:Map_Module. A list of the file types supported by SMS is available here: http://www.aquaveo.com/supported-file-types.

2.4.3.2 Model setup approach

While constructing the GenCade grid, it is recommended that the user start with a simplistic, barebones representation of the study site to make sure the model is running correctly. If the user still has doubt regarding the suitability of the model, initial simulations with this simple grid should give a definitive answer. The simple grid should include a shoreline, a wave gauge, and key model parameters such as the grid length, orientation, cell size, and boundary conditions. Once everything is running error-free, the user can go back to the conceptual model and include inlets, the regional contour, structures, and activities and test each addition to make sure the model continues to function properly. This stepwise approach will facilitate identification of errors and also improve the understanding of model features and capabilities.
2.4.4 Calibration, validation, sensitivity testing

The calibration process consists of simulating with GenCade a period of time where the initial and the final condition (shoreline) are known. All engineering activities, inlets, and structures must be represented during the simulation time. The calculated shoreline is then compared with the measurements, and calibration parameters are adjusted to improve agreement. Once calibration is complete, the model should be validated by keeping the final calibration parameters constant while simulating another period of time for which the final results are known. The validation is used to estimate the predictive capability of the production runs.

2.4.5 Production runs

Once the GenCade grid has been calibrated and validated, the modeler should start developing a specific set of alternatives to address the study questions. Based on the calibrated model the modeler can easily make changes in the conceptual model and quickly generate new alternatives. The modeler should save new alternatives in different folders to distinguish like-named files.

2.4.6 Analysis and interpretation of the results

The user can easily visualize the shoreline change and transport rates in SMS. However, if the user wishes to calculate statistics on the results, the data can easily be exported to an ASCII file and processed with a program of choice (MATLAB, Microsoft Excel, etc.).
3 Quick-Start Guide

This section provides the prospective GenCade user with a simplified guide to get started on a GenCade project. A more in-depth user’s guide is available in Chapter 4 of the GenCade Report 1 and on the CIRP wiki page. Workshop material and the recorded webinar are also available on the CIRP web page under Tech Transfer tab. Video tutorials illustrating the steps listed below are currently in production and will be available on YouTube with full URL listings on the CIRP website.

3.1 Create a workspace

Once the user is ready to get started on a GenCade project, the first step is to open SMS 11.1 (or later) and set up a workspace. Figure 1 shows what the user will see when a blank SMS window is opened. An introduction to the SMS environment may be found on the Aquaveo wiki website www.xmswiki.com/xms/SMS:SMS.

Figure 1. The SMS graphical interface and common nomenclature.
3.1.1 Set global project and units

Before entering data into the conceptual model, the user should set the desired global geographic projection of the workspace. This action will ensure that all the data entered in the SMS will be automatically converted and displayed in that projection. The projection can be set by going under the Display menu, then Projection, then by selecting the Global projection radio button and choosing the desired projection from the dropdown menu. As data (imagery, shoreline, etc.) are imported into SMS, the Project Explorer will be populated. Each data set can be entered in a different projection as long as its projection is correctly specified by right-clicking on its respective coverage (in the Project Explorer) and selecting projection. This will ensure SMS knows which conversion to apply to display the data properly.

The Projection menu is also where the user can set the horizontal units to the U.S. Customary Units (U.S. Survey Feet) or to the metric system (Meters). If U.S. Customary Units are selected, then all output will be in feet, cubic yard, etc., and input data such as berm height or cell size must be entered in feet with the exception of wave height and grain size, which are always entered in meters and millimeters, respectively.

More information on setting up the workspace and projection can be found in Sections 4.2.1 to 4.2.3 of GenCade Report 1.

3.1.2 Locate GenCade executable

During the installation of SMS, a folder named models will be generated under the main SMS directory. This folder contains the executable of the models provided with the license. The last released version of the GenCade executable will be placed there. If the GenCade executable to be used is different from the one provided with the SMS installation, the user may map the location of the new GenCade executable from the menu under Edit->Preferences-> File location tab. Generally, an updated executable may be retrieved from the CIRP website or requested from one of the authors.

3.1.3 Save project

At this point, the user may save the SMS project by selecting File->Save As. This action will generate a series of SMS-related files. A description of
those files is available in Appendix A. To reopen the project, drag the *.sms file into the SMS workspace (or alternatively, select File->Open and select the *.sms file to open). Information on project file path and sharing projects may be found in Sections 3.2.10 and 3.2.11 of GenCade Report 2. Settings such as executable location, global projection and display preferences may be saved under the File->Save Settings menu. The user should note that SMS interface does not have an undo button. It is good practice to save often. Individual coverage may be saved in a *.map file by highlighting the coverage and going under File/Save Map.

3.2 Importing project-related imagery, CAD, and ESRI shape files

3.2.1 Import imagery

A good-quality image spanning the length of the project will be very helpful to set up the GenCade project. The user can import a georectified aerial photograph or satellite image by dragging the image into the SMS workspace. The image name will be listed under the SMS Project Explorer where it may be checked or unchecked to display the image. The SMS also offers the capability to import web map service imagery from external servers. In order to access these images, the user should select Web -> Add Online Maps. Web map services such as ESRI World Imagery, USDA NAIP color orthophoto imagery, or ESRI World Street Maps may be selected. If the user would like to manually save a smaller static image from an external web map service server, the user should select Web -> Import from Web. This newly created map will be saved as a *.web file. In both cases, the modeler should be aware that the source of the imagery is from an external server, and the data may download and render slowly.

3.2.2 Import CAD and ESRI shape files

Engineers starting a GenCade project will often have a CAD drawing or ESRI shape files available with the project design components. The *.dwg and *.shp files can be easily loaded in the SMS by dragging them into the workspace.

3.3 Create a GenCade initial shoreline

Now that the workspace is ready, the user may start entering the objects that will encompass the conceptual model. The shoreline is usually the first data that are incorporated.
Shoreline data should consist of a series of \(x\)- and \(y\)-coordinates for each point, ordered in the same way they would appear if a person were to walk along the shoreline from the origin point to the end of the grid. The shoreline must not wrap around itself, and only one shoreline position is possible at each point on the 1D grid. If the user possesses a data set of points already ordered, the data sets may be imported in a *.cst format. The user can follow these steps to import data into the SMS Project Explorer.

### 3.3.1 Create the *.cst file

Figure 2 below shows an example of the *.cst file. There is a three-line header preceding the list of \(x\)- and \(y\)-coordinates. Copy the header and change the number 574 in the example below to the total number of points listed in the file. Save with the *.cst extension.

![Figure 2. Coastline file (*.cst).](image)

A full description of the file format may be found at [http://www.xmswiki.com/xms/SMS:Coastline_Files_*.cst](http://www.xmswiki.com/xms/SMS:Coastline_Files_*.cst).

### 3.3.2 Load the file into SMS

Drag and drop the *.cst file into the SMS workspace. If the data are in the same coordinate system as the workspace, the shoreline should overlay the imagery correctly. Otherwise, right-click on the coverage and specify the projection in which the data occur under *Projection (floating)*.

The shoreline should be one continuous arc (polyline), and therefore, any inlets must be closed. If the shoreline does not appear as a single arc, follow the procedure described in Section 4.2.4 of GenCade Report 1.
3.3.3 Define coverage as GenCade

In the Project Explorer, the shoreline will automatically be placed into the default coverage under the Map Data. Right-click on the default coverage and select Type->Model->GenCade so that the GenCade attribute window is activated. Alternatively the coverage could be defined prior to loading the shoreline.

3.3.4 Define arc as initial shoreline

As data such as shorelines, inlets, and groins are imported into the SMS workspace under the form of Arcs (polyline), the user needs to define the Attributes of those Arcs so that SMS will treat the arc features according to type. Highlight or click on the coverage that contains the initial shoreline data and select the Select Feature Arc (Table 1) tool from the toolbar. Double-click on the shoreline and select Initial Shoreline from the drop-down menu of the GenCade Arc Attribute window.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Tool</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Feature Point</td>
<td><img src="image" alt="icon" /></td>
<td>Select Feature Arc</td>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td>Create Feature Point</td>
<td><img src="image" alt="icon" /></td>
<td>Create Feature Arc</td>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td>Select Feature Vertex</td>
<td><img src="image" alt="icon" /></td>
<td>Create 1-D Grid Frame</td>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td>Create Feature Vertex</td>
<td><img src="image" alt="icon" /></td>
<td>Select 1-D Grid Frame</td>
<td><img src="image" alt="icon" /></td>
</tr>
</tbody>
</table>

3.3.5 Inspect the shoreline for accuracy

Move, delete, or add a vertex to the shoreline by selecting the Select Feature Vertex tool (Table 1). It is recommended to smooth out shoreline outliers or sudden changes in shoreline orientation especially near inlets. A built-in smoothing algorithm may be used for this purpose. To do so, select the shoreline arc with the Select Feature Arc tool, right-click and select Smooth Arcs from the drop-down menu. Inspect the shoreline for accuracy. Remember to save the shoreline before running the smoothing tool since there is no undo button (save as a *.map file) or duplicate the initial shoreline by right-clicking on the coverage and selecting duplicate.
More information on the smoothing function may be found at
http://xmswiki.com/xms/SMS:Arcs#Smooth_Arc and additional details on the dynamic
tools can be found at http://www.xmswiki.com/xms/SMS:Map_Module_Tools.

### 3.3.6 Using other data formats

The SMS interface has its own built-in GIS tools that can be used to extract
shoreline data from an ESRI Shapefile or from scatter sets such as a lidar
survey or beach survey data. For further details, refer to Section 4.2.4 of
GenCade Report 1 or review the online tutorial on initial shoreline.

### 3.4 Is a regional contour needed? Creating a regional contour

Shoreline position calculated with a one-line, wave-driven longshore
transport model such as GenCade will tend to straighten with simulation
time. The regional contour is a way to preserve the prominent permanent
features of a shoreline such as a rocky headland or a particular shape given
by the underlying geology. Over time, given a consistent wave forcing, the
calculated shoreline will not straighten but rather resemble the
regional contour. If the shoreline over the study area is not relatively
straight and the user wishes to execute simulation over relatively long time
period, the user should use a regional contour. It is recommended that the
model be run without the regional contour at first and incorporate the
regional contour only once a working simple grid is achieved.

A good regional contour should follow the general shape of the shoreline
but not include the smaller features (< 5 kilometers) such as a salient,
attachment bars, etc. The contour may be based on a smoothed version of
the initial shoreline, a historical shoreline with a pre-inlet condition, an
offshore bathymetric contour, or an average of several shorelines. The
regional contour will have an important effect on the final result, and great
care should be taken in determining its optimal shape. An in-depth
discussion of the regional contour is presented in Section 4.6 of GenCade
Report 2. That section also presents a detailed procedure for the creation
of the regional contour. A simplified procedure is presented here.

### 3.4.1 Use a shoreline or contour

A good starting point is to use a smoothed version of a historical or current
shoreline or an offshore contour. Import the shoreline into a new coverage.
To create a new coverage, right-click on *Map Data* folder (in the *Project*
Explorer) and select New Coverage from the drop-down menu. Drag and drop the *.cst file into the workspace making sure the new coverage is highlighted. Right-click on the coverage containing the proto-regional contour and select Duplicate in order to preserve the original version. It is important at this point that the initial shoreline and the proto-regional contour exist in separate coverages. Right-click on the shoreline using the Select Feature Arc tool and select the Smooth Arc(s) menu. Experiment with various Number of neighbors values by duplicating the proto-regional contour many times (recall that there is no undo button). Start with a small number of neighbors and increase these incrementally until the smaller irregularities are smoothed out, leaving the predominant, permanent shoreline features visible. Delete an unwanted coverage by right-clicking on the coverage and selecting Delete. An individual vertex can also be moved if needed using the Dynamic Tools.

3.4.2 Define coverage and attributes

Once a satisfactory contour is made, define the coverage as GenCade and define the Attributes of the contour as Regional Contour as described in the previous section.

3.4.3 Save map files

At this stage, the user should have two coverages, one with the initial shoreline and one with the regional contour. It is recommended that the individual coverage (*.map file) be saved for easy access later, if needed. Highlight the coverage to save and go under File->Save Map. Map files may then be loaded by dragging them into an SMS workspace or alternatively, by selecting File -> Open and selecting the *.map file. Users should also save the entire workspace (*.sms).

3.4.4 Merge coverages

The initial shoreline and the regional contour need to be merged into a single coverage. All structures, inlets, wave gauges, and other features will be created in this single coverage. Highlight both coverages (initial shoreline and regional contour) from the Project Explorer by holding ctrl on the keyboard and clicking on both coverages. After right-clicking, select Merge Coverages. Save the workspace. The single coverage containing the shoreline and the contour is defined as the conceptual model. Common
mistakes encountered when merging coverages are presented in Section 3.2.3 of GenCade Report 2.

3.5 Processing and inputting wave data

GenCade is a wave-driven sediment transport model; therefore, the quality of results will depend greatly on the quality of the wave forcing. The required wave parameters are date and time (YYYY MM DD hh:mm), significant wave height (meters), wave period (seconds), and incoming wave angle (degrees) at regular time intervals. The wave angle may be entered in different conventions: meteorologic, oceanographic, Cartesian, or shore-normal (Figure 3). Since the shoreline orientation varies along the grid, the line of reference in shore-normal convention (Figure 3, D) is the grid x-axis. This convention can only be used after a 1D GenCade grid is generated. For the Cartesian convention, the line of reference is always the horizontal. Location and water depth of the wave gauge are also needed. Data may come from measured wave data (e.g., NOAA-NDBC buoy data) or long-term model hindcast (e.g., USACE-WIS data). In some cases, a representative wave record may be constructed. The wave record must be continuous with no gaps, but the time interval does not have to be the same as the user-specified simulation time-step. It is necessary to have a wave record that will at least cover the simulated period, but the start and end date of the wave record do not have to be identical to that of the simulation period since the user will be able to enter the start and end date of the desired simulation period. However, it is not recommended that a wave record many times longer than the simulation period be utilized since the entire wave record will be saved in the *.wave file and will take up extra hard disk drive space.

If the offshore bathymetry of the study site presents shallow or deep features that affect wave propagation in the nearshore, it can be difficult to properly model the sand transport magnitude and direction. In this case, it might be necessary to use an external wave model to calculate wave propagation from the wave gauge water depth to a location just offshore of the breaking point. A series of numerical wave gauges with the data calculated from the external wave model can be used as input in GenCade. The use of GenCade with an external wave model is presented in Connell and Permenter (2013) and Permenter et al. (2013).
Figure 3. Wave angle convention in SMS. A) Meteorological: direction clockwise from true North to the direction the waves are coming; B) Oceanographic: direction clockwise from true North to the direction the waves are going; C) Cartesian: direction counterclockwise from the horizontal to the direction the waves are going; D) Shore-normal (grid-normal): angle between the right angle from the x-axis and the direction waves are coming. A positive angle means the waves are traveling in the positive x-axis direction.

The number of wave gauges will depend on the available data. If there are several potential wave gauges available (e.g., wave data from model hindcast), it is recommended to use one at least every location where there is a significant change in the shoreline orientation or the offshore bathymetry. It is recommended that the model be tested with only one wave gauge at first and incorporate more as necessary. Below are the steps to import wave data into the SMS workspace.

3.5.1 Enter location of wave gauge(s)

The user must create a feature point at the geographical location of the wave gauge in the coverage containing the shoreline data. Select the Create Feature Point tool (Table 1) from the toolbar and click the location of the wave gauge. Once the point is created, its exact coordinates may be manually entered in the X and Y boxes located above the Data Tree window. If the x-y coordinates are known but in a different projection than that of the workspace, the user may use the built-in coordinate transformation tool under Display->Single Point Projection. When using the transformation tool, check the Create Feature Point box to add the point to the workspace.
3.5.2 Load wave data

Click on the Select Feature Point tool (Table 1), double-click the point representing the wave gauge, and check Wave Gage from the Refine point window. The Options button will open a window where the water depth of the gauge is entered. Click on Data to open the Wave Events window. This window will allow the user to either manually enter wave data, copy and paste data from a text/data editor, or import the wave information from an ASCII file. If the wave information is in Microsoft Excel or a text editor, it may be easier to load the file using the File Import Wizard. To facilitate the import process, place each field (year, month, day, hour, Hs, Tp, Dir) in a separate column. Click the import button at the bottom of the Wave Events window and follow the steps of the import Wizard. Alternatively, the user can directly copy/paste the data into the Wave Events window if the following seven-columns format is used: [YYYY MM DD HH:MM Hs Tp Dir]. Select the proper convention used for wave direction and click OK; a red arrow will appear over the wave gauge indicating the direction of the first wave event. If the available data are in the shore-normal convention, the user must create the grid first (see GenCade Report 1 Section 4.2.18). Save workspace.

Common mistakes while importing wave data are addressed in Sections 3.1.1.3 and 3.2.6 of GenCade Report 2.

3.6 Adding structures and engineering activities

Inlets, structures, and engineering activities are entered in GenCade by creating an arc (polyline) that is representative of the spatial extent (shape and position) of the inlet, structure, or operation and defining its attributes in the conceptual model. The attribute window is used to enter the type and properties of the structure or activity. All arcs must be created in the same coverage (conceptual model) associated with the initial shoreline and regional contour.

3.6.1 Create inlet

Turn on the imagery, zoom to the location of the inlet, and select the Create Feature Arc tool from the toolbar. Draw a line across the inlet channel from bank to bank. The arc can be drawn seaward or landward of the shoreline (initial or regional contour), but the arc must not attach to any of the shoreline nodes (refer to p.119 of GenCade Report 1 if it does).
Using the *Select Feature Arc* tool, double-click on the arc to prompt the attribute window. Select *Inlet* from the drop-down menu to activate the *Attributes* button. The *Attributes* button will lead to a window dialogue where inlet properties such as shoal volumes and dredging events are entered. Modify these values to match the properties of the inlet being defined and close the dialogue and save.

Properly defining the inlets is a crucial part of a GenCade project and can be difficult. A user should become familiar with the Inlet Reservoir Model (IRM) if inlets are present in the study area. See discussions in Section 2.11 of GenCade Report 1 and Section 4.7 in Report 2.

### 3.6.2 Jetties

Jetties are created in a similar way as an inlet: by drawing an arc at the location of each jetty. Extend the arc landward of the shoreline taking care that the arc node does not attach to the existing arcs and shorelines. The attribute window will list *Left Jetty on Inlet* or *Right Jetty on Inlet*. In order to determine if a jetty is considered *left* or *right*, the user should imagine standing on land, looking out at the ocean. As illustrated on Figure 4, the *left jetty* would be to the left of a person standing in the location described. Refer to the GenCade Report 1, Section 4.2.7 for more information of the available properties such as permeability and diffraction.

![Figure 4. GenCade grid orientation convention.](image-url)
3.6.3 Other structures and engineering activities

Groins, seawalls, and breakwaters are created similarly to the inlet; however, the attributes will change depending on which type is selected. Specific details may be found in GenCade Report 1 (groins and T-groins in Section 4.2.14 and 4.2.15; detached breakwaters in Section 4.2.11; seawalls in 4.2.8). Sections 3.2.2 and 3.2.4 of GenCade Report 2 describe issues with the placement of structures and the solutions. Several beach fill dates may be entered in the attribute window for a single location. If the beach fill does not have the same location, then multiple arcs must be drawn (GenCade Report 1 Section 4.2.9).

3.7 Creating a GenCade grid

The computation along the GenCade grid follows a right-hand coordinate system with the $x$-axis following the main trend of the shoreline and the $y$-axis perpendicular to it and pointing offshore. Therefore, if a person followed the shoreline from the beginning to the end of the grid ($x$-axis), the water should always be to the left and the land should always be to the right (see Figure 4 for details). The grid orientation should match the orientation of the shoreline to the least degree difference possible. If there is a large change in shoreline orientation, it might be best to create two (or more) adjacent grids (see Frey et al. 2012b for an example of multiple grids used for a curved shoreline). Results are the most accurate when shoreline deviation from the $x$-axis stays within $\pm25$ degrees (see Section 4.3 of GenCade Report 2 for further discussion on grid orientation). The user may specify a maximum of 4,000 cells to define a domain. The cell resolution may be distributed uniformly or variably alongshore; recommendations on grid cell spacing are provided in Section 4.2 of GenCade Report 2. Once a grid frame is created, SMS will convert all the arcs and shorelines of the conceptual model into a 1D grid system called a GenCade grid. The steps to generate a GenCade grid are below.

3.7.1 Create grid frame

Select the Create 1-D Grid Frame (Table 1) icon from the toolbar and click at the location of the desired start and end points of the grid keeping in mind the coordinate system. It is best to position the start and end points of the grid where the boundary conditions are known. Read further on boundary conditions in GenCade Report 1 Sections 2.6, 4.3.3 and 4.3.4 and in Report 2 in Section 3.2.5. In addition, a TR discussing the lateral boundary
conditions (King, in preparation) will be released in 2015. The grid should be created in the same coverage as the shorelines and arcs and located at some distance inland of the shoreline so that all shorelines and arcs are located on one side of the grid frame. Use the Select 1-D Grid Frame tool to modify grid length and azimuth. To make the modifications, the user can either manually click and drag the grid frame handle (small squares that appear when the grid frame is selected) or prompt the Grid Frame Property Window by right-clicking on the grid frame. Note that the Angle in the Property Window refers to the angle convention in the conceptual model, which is degrees counterclockwise from the horizontal (Cartesian).

3.7.2 Define cell size

The cell size and number of cells are defined in the Grid Frame Property Window. A constant grid resolution is reasonable for most projects. However, there are some large-scale projects that would benefit from variable grid resolution. Section 4.2.16 of Report 1 provides more information on how and why to create a variable cell size grid.

3.7.3 Convert map to 1D grid

Once all of the shorelines, inlets, structures, and wave gauges have been added to the conceptual model, save the project, right-click on the coverage, and select Convert-> Map->1-D Grid. A window will open showing the origin and orientation of the GenCade grid and the different cell options; adjust as necessary and click OK. This action will convert the position of arcs and shorelines from real world coordinates to a 1D GenCade coordinate system that will be used for model calculation. The 1D GenCade grid will appear in the SMS Project Explorer and may be viewed in the SMS workspace. If the user clicks on and highlights GenCade Data, the GenCade menu at the top of the interface will appear. Uncheck the display box of the map coverage so that only the GenCade grid is visible and inspect the converted position of the shoreline, structures, inlets, engineering activities, etc.

3.7.4 Making modifications to the arcs

Whenever possible, it is best to use sufficient spatial resolution and orient the grid to resolve the position and dimensions of the features represented by arcs in the conceptual model. However, there are times in which it might be necessary to modify the position of the arc in the conceptual model, so it
is properly represented in the 1D grid system. To modify the shorelines, arcs, or grid frame, click and check the display box of the merged coverage containing the arcs. This action will reactivate the dynamic toolbar. Use the Select Feature Point tools to make necessary modifications by clicking and dragging the end node of an arc and changing the position. Once the modifications are completed, save and reconvert the Map to 1-D Grid and inspect the results of the updated GenCade grid.

3.7.5 Save control file

Once the grid has been defined, the user should save the workspace. A file with the *.gen extension will be created in the working directory. This is the control file read by the GenCade executable. It records the details for structures, inlets, model setup, etc. Each time the workspace is saved in SMS, the *.gen file is updated. A description of the other GenCade input files generated is presented in Appendix A.

3.7.6 Note on the GenCade menu

Once the grid is generated, a GenCade menu will appear at the top of the SMS window. The values in the GenCade menu are read from the control file (*.gen). This menu may be used to make minor changes to the project and to double-check that all features defined in the conceptual model are represented in the grid. When the project is saved, changes will be saved in the control file. Changes made within the GenCade menu will be lost if the grid is regenerated, but changes made in the conceptual model will be applied to the grid each time it is generated. In the calibration process, the user might want to use the GenCade menu to test different values, parameters, or positions, for example. Once a best value is selected, these changes should be implemented to the conceptual model to avoid having to re-enter them after each grid generation.

3.8 Control parameters and execution of the model

The GenCade control window is used to enter the other simulation-specific information such as time-steps, boundary conditions, and empirical coefficients. To access the model control, highlight GenCade Grid in the Project Explorer to activate the GenCade menu. From the GenCade menu go to Model Control.
3.8.1 Model setup

The time-step and simulation start and end dates are entered in the first tab. The simulation time-step must be less than or equal to the wave time-step and must satisfy the stability parameter discussed in Section 4.4 of GenCade Report 2. The Recording Time Step is the interval of time at which the shoreline position output, the offshore wave transformation contour output, the instantaneous transport rate output, the volume change per grid cell output, the volume change per alongshore distance unit output, and inlet shoal volume evolution output are written in the output files (*.slo, *.off, *.qtr, *.vcc, *.vcx, *.irv, respectively). The annual mean transport files, *.mqn (net), *.mqr (to the right), *.mql (to the left), are written yearly from the simulation start date, but additional dates can be entered in the Print Date box. A list of the output files and their description is available in Appendix A; in addition, more information about these output files is available in Section 4.1 of GenCade Report 1.

3.8.2 Beach setup

Information related to the beach profile and transport coefficient is entered under the Beach Setup tab. The grain size is always in millimeters (regardless of the horizontal distance units). K1 and K2 are dimensionless empirical coefficients used in the longshore sand transport calculation (CERC formula). These values should be adjusted during the calibration process. Default values are 0.5 and 0.25, respectively. Details about the transport formula are discussed in Section 2.2 of GenCade Report 1 and Section 2.1.2 of GenCade Report 2.

3.8.3 Seaward boundary condition (BC)

Values related to the wave transformation calculations are entered in the Seaward BC tab. Input wave adjustments are used to apply a correction to all the input wave data (either wave height or direction). Adjustments to the default value can be useful to conduct wave climate sensitivity analyses. The other important option is the Number of Cells in the Offshore Contour Smoothing Window or ISMOOTH value. Because the shoreline orientation can change abruptly in some instances, GenCade uses a smoothed offshore contour in performing the internal wave calculation to avoid unrealistic wave transformation. The ISMOOTH value regulates how smooth or how detailed the offshore contour is. ISMOOTH = 1 would result in an offshore contour that would be parallel to the shoreline, whereas ISMOOTH = NX
(where NX is the number of alongshore grid cells in the grid) would result in a straight contour line parallel to the x-axis. ISMOOTH must be adjusted in the calibration process. Section 4.5 of GenCade Report 2 provides a detailed discussion and recommendations on how to find the optimal value.

### 3.8.4 Lateral BC

The user specifies the type of BC to be used at the start and end of the grid under the Lateral BC tab. The default is Pinned BC, which means that the transport rate is constant across the boundary and therefore no shoreline change over the simulation period at the boundary. Moving BC may be used when the shoreline displacement over a set period of time is known. A Gated BC offers the capability to start or terminate a GenCade grid at a groin or other hard coastal structure such as a large rock or headland. This BC performs bypassing and transmission of sand similar to an interior groin but with an assumed stationary virtual shoreline position outside of the domain. In this case, a groin must be created in the conceptual model at the left or right end of the grid. If the right lateral boundary is defined as a gated boundary, the groin should be at cell number of NX+1, where NX is the total number of cells in the grid. The grid position of the groin may be manually changed in the GenCade menu under Groin to assure correct position. See Section 3.2.5 of GenCade Report 2 on common gated BC problems. A TR focusing on lateral boundary conditions is in preparation (King, in preparation).

### 3.8.5 Run GenCade

The user should always save the workspace before running in order to update the control file (*.gen). To run GenCade, go to the GenCade menu and select Run GenCade. A window will open that describes the simulation. This window will notify the user if an error has occurred. If an error occurs, review Section 3.2 of GenCade Report 2 on common set-up mistakes. If a warning about instability occurs, the user might want to reduce the time-step or increase the cell size. A discussion on the stability parameter is provided in Section 4.4 of GenCade Report 2.

### 3.9 How to view and export the results

The procedure to visualize and export the data is explained in Section 4.4 of the GenCade Report 1 and summarized below.
3.9.1 Visualizing output

As the simulation ends, the user may drag into the workspace the shoreline evolution file, *.slo, located in the same folder where the project was created. The final shoreline will be displayed and the Time Steps box will appear allowing the user to inspect the calculated shoreline at various times during the simulation. Right-clicking at the top of the Time Steps box will allow the user to change time settings (time-steps or date format). The transport rate files (*.qtr, *.vcc, *.vcx, *.mqn, *.mqr, *.mq1) may also be viewed in a similar way. The GenCade grid line will act as the \( y=0 \) axis for visualization of the transport. Use the Display->Display option menu to change line color and thickness.

3.9.2 Making plots

The data may be displayed into printable figures using the SMS plot wizard. Go under Display->Plot Wizard and select GenCade Shoreline from the Plot Type box (on the left side of the window), click Next, then select the Specified dataset(s) option, and select the dataset to be plotted. Once the plot is generated, display options and properties can be changed by right-clicking on the plot.

3.9.3 Visualizing inlet shoal volumes

Inlet shoal volume evolution may be visualized using the Plot Wizard. Using the method described above, select GenCade Inlet TS from the Plot Type box and click Next. The user can plot the various variables (flux and volume) calculated in the inlet reservoir model. Figure 14 of the GenCade Report 1 and Section 4.7 of GenCade Report 2 provide additional documentation on IRM variable names and functions.

3.9.4 Export data

The data may easily be exported to a text editor using the Plot Wizard. After a figure is created by following the instructions under the Making Plots Section 3.9.2, right-click on the figure and select the Export/Print function from the menu. Select the Text/Data option to copy the data to the Clipboard and then paste the data into a text editor or a spreadsheet.
3.9.5 Print file

The print file *.prt is the original output file. The file holds the transport (gross, net, right, and left) and shoreline position after each simulated year. It also lists information such as the breaking wave angle and height (at specific time step), the calculated volume change, the calculated seawardmost shoreline position, the calculated landwardmost shoreline position, and the stability parameter if instabilities occur. It cannot be viewed in SMS, but the user can look up specific information using a text editor with a search function. Section 3.1.4 of the GenCade Report 2 describes the details of the *.prt file while Section 4.4 of GenCade Report 1 explains how the *.prt file can be used.

3.10 Calibrate the model

The calibration process is the most important and most difficult part in performing a GenCade project. Clear understanding of the model and a deep knowledge of the study site are essential for the calibration process. The process consists of simulating a period of time where the initial and the final condition (shoreline) are known. The calculated shoreline is then compared with the measurements, and calibration parameters are adjusted to improve agreement. A good discussion on the GENESIS calibration process is available in Gravens et al. (1991); additional GenCade discussions are provided in Section 4.1.5 of GenCade Report 2 and Section 4.5 of GenCade Report 1.

3.10.1 Comparison of measured and observed final shorelines

To facilitate the comparison of the measured and observed shorelines, it is useful to import the measured shoreline into the workspace. Drag and drop the shoreline file (ASCII, ESRI shapefile, etc.) into the workspace. However, to compare the measured and calculated shorelines in a spreadsheet to calculate goodness-of-fit statistics, for example, the measured shoreline position must be defined at or interpolated to the same x-location on the grid as the calculated shoreline. The procedure is described at the end of Section 4.4 of GenCade Report 1.

3.10.2 Calibration

The first step in the calibration procedure is to adjust the parameters (K1, K2 and ISMOOTH) that will have an influence on the entire simulated domain. Sometimes adjustments improve an area while worsening another;
it is up to the modeler to judge which portion(s) of the study region require a higher level of confidence. Parameters should be adjusted one at the time to really understand the impact. $K_1$ regulates the magnitude of the longshore transport and should be calibrated first. It may be adjusted using final shoreline position or known annual gross and net transport rates from previous studies. The $K_2$ coefficient and the ISMOOTH value (Section 4.5 of GenCade Report 2) influence the shoreline position in the vicinity of structures or where there is a sharp change in shoreline orientation; $K_2$ and ISMOOTH should be calibrated jointly.

### 3.10.3 Calibration of shoreline near inlets

Various tools are available for the user to improve the calculated shoreline position near inlets. Sometimes if the initial shoreline dips too far into the inside of the inlet bank, it might create excessive shoreline change. Adjustments to the initial shoreline can be made using the procedure described in Section 4.5.1 of GenCade Report 1. Adjustments to the bypassing coefficients (Section 4.7.5 of GenCade Report 2) will regulate the amount of sand that is trapped by the updrift jetty. The position and length of the attachment bars (Section 4.7.4 of GenCade Report 2) may be adjusted to regulate the sand distribution on the downdrift shoreline. The ratio between the initial and equilibrium shoal volumes will dictate the bypassing rate of the inlet (Section 4.7 of GenCade Report 2).

### 3.10.4 Calibration of shoreline near structures

In addition to the aforementioned $K_2$ and ISMOOTH parameters, structure-specific parameters such as permeability and the transmission coefficient will have an influence on the adjacent shoreline. The cell size and numbers must also be considered when several structures are close to each other, such as a groin field. In this case, it might be necessary to use variable grid spacing (Section 4.2.16 of GenCade Report 1 and Section 4.2.2 of GenCade Report 2).

### 3.10.5 Regional contour

While not a calibration parameter, the regional contour greatly impacts the final results. The regional contour should not be used to dictate the behavior of the shoreline during calibration, but in some instances, it might be necessary to make small local modifications. Section 4.6.3.4 of
GenCade Report 2 describes when to modify the regional contour, and Section 4.5.1 of GenCade Report 1 explains how it is modified.

3.10.6 Sources and sinks

In some instances, it might be useful to use a sink or source term to account for known processes not accounted by GenCade. Examples where it may be appropriate to use a source or sink term include documented loss of sand due to overwash episodes or wind transport, unavailability of erodible material, backpassing or bypassing plants, etc. The sink/source is created similarly to a beach fill but the Attributes are specified as Bypass Event.

3.10.7 Validation

Once the model is calibrated, the next step is to perform a validation case to assess the skill of the model. The process involves running GenCade for another time period while holding the calibration parameters fixed. The validation simulation output is then compared against an independent verification data set (e.g., a measured shoreline at a time different from the calibration shoreline) to assess model skill and evaluate quantitative verification statistics.

3.11 Production runs and final product

Once the model is calibrated and validated, the user should have a good idea of the skill of the model. Further sensitivity and statistical analyses can be performed to improve the understanding of the model behavior and goodness of fit. These topics will be further discussed in the upcoming calibration and validation TR.

At this point, the user may easily make modifications to the project components to test various alternatives and evaluate answers to the project questions. Section 4.1.6 of GenCade Report 2 provides a discussion on production runs while Section 4.5 of GenCade Report 1 explains how to make the changes to the conceptual model.
4  **Summary and Conclusions**

GenCade is a shoreline change model built on the combination of previous shoreline change models GENESIS and Cascade. The objective of this publication is to provide new and prospective users with a starting point to learn GenCade. The first portion of the SR gives a quick overview of the model and provides guidance for its suitability for a given project site. The second portion is a quick-start guide that allows a new user to get started rapidly on a project, from collecting the data to the completion of production runs. The intent of the SR format is to supply the new user with concise information to quickly assess what the model does, what types of data are necessary, and how it works instead of endeavoring through the more laborious details provided in a TR. Throughout the document, precise references to in-depth discussion on each topic are provided.

It is recommended that the new user consult GenCade Report 1 (Frey et al. 2012a) and GenCade Report 2 (Frey et al. 2014) for further background on GenCade. Beck and Legault (2012), Frey et al. (2012b), Rosati et al. (2013), and Thomas and Dunkin (2012) address completed GenCade projects. There are also several TR in progress that will describe specific GenCade topics like the external wave model and calibration. Finally, if a user has a question about GenCade, the authors may be contacted: Ashley Frey (ashley.e.frey@usace.army.mil) or Sophie Munger (sophie.munger@bluesciencellc.com).
References


Thomas, R. C., and L. Dunkin. 2012. Erosion control and environment restoration plan development, Matagorda County, Texas, phase 1. ERDC/CHL TR-12-08. Vicksburg, MS: U.S. Army Engineer Research and Development Center.
Appendix A: File Descriptions

Table A1 describes the files that are generated when saving a SMS project.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.sms</td>
<td>SMS project file</td>
<td></td>
</tr>
<tr>
<td>*.map</td>
<td>When SMS saves a project, all the data related to coverages in the Map Module are written to a single ASCII file.</td>
<td>The map files can be saved individually.</td>
</tr>
<tr>
<td>*.materials</td>
<td>Contains an index of the ID of some data entities constructed and edited in SMS</td>
<td>Autogenerated</td>
</tr>
</tbody>
</table>

Table A2 lists the GenCade input file names, description, and units. These files are generated once a conversion to the 1D grid is made and the workspace is saved. These files are inputs for the GenCade execuTable.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
<th>Units (U.S. Customary)</th>
<th>Unit (Metric)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.shi</td>
<td>y-position of the initial shoreline at each grid cell; required.</td>
<td>Distance from grid (feet)</td>
<td>Distance from grid (meters)</td>
</tr>
<tr>
<td>*.gen</td>
<td>GenCade control file; required</td>
<td>Varies</td>
<td>Varies</td>
</tr>
<tr>
<td>*.wave</td>
<td>Wave file: date, hour, wave height, wave period, wave direction (shore-normal); required</td>
<td>Meters, seconds, degrees</td>
<td>Meters, seconds, degrees</td>
</tr>
<tr>
<td>*.shr</td>
<td>y-position of the regional contour at each grid cell; optional</td>
<td>Distance from grid (feet)</td>
<td>Distance from grid (meters)</td>
</tr>
<tr>
<td>*.shdx</td>
<td>Variable grid resolution file; length of each cell; optional</td>
<td>Feet</td>
<td>Meters</td>
</tr>
<tr>
<td>*.wl</td>
<td>Water-level (WL) file for time-dependent wave transmission over breakwater; (Date, hour, WL from mean sea level (MSL)</td>
<td>Feet</td>
<td>Meters</td>
</tr>
</tbody>
</table>

Table A3 lists the GenCade output file names, description and units. These files are generated after the execution of the model.
Table A3. GenCade output file names, descriptions, and units.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
<th>Units (U.S. Customary)</th>
<th>Unit (Metric)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.prt</td>
<td>Print file (shoreline, volume, transport)</td>
<td>Varies</td>
<td>Varies</td>
</tr>
<tr>
<td>*.slo</td>
<td>Calculated shoreline position for each grid cell at each output time-step</td>
<td>Distance from grid (feet)</td>
<td>Distance from grid (meters)</td>
</tr>
<tr>
<td>*.qtr</td>
<td>Transport rate at each grid cell averaged for the period between each output time-step and converted to per-year</td>
<td>Cubic yards/year</td>
<td>Cubic meters/year</td>
</tr>
<tr>
<td>*.irv</td>
<td>Calculated inlet shoal volumes and fluxes at each output time-step</td>
<td>Volume (cubic yards)</td>
<td>Volume (cubic meter)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flux (cubic yards/year)</td>
<td>Flux (cubic meters/year)</td>
</tr>
<tr>
<td>*.mqn</td>
<td>Calculated mean annual transport rate</td>
<td>Cubic yards/year</td>
<td>Cubic meters/year</td>
</tr>
<tr>
<td>*.mql</td>
<td>Calculated mean annual transport rate to the left</td>
<td>Cubic yards/year</td>
<td>Cubic meters/year</td>
</tr>
<tr>
<td>*.mqr</td>
<td>Calculated mean annual transport rate to the right</td>
<td>Cubic yards/year</td>
<td>Cubic meters/year</td>
</tr>
<tr>
<td>*.off</td>
<td>Calculated offshore contour position at each output time-step</td>
<td>Distance from grid (feet)</td>
<td>Distance from grid (meters)</td>
</tr>
<tr>
<td>*.vcc</td>
<td>Total volume change per cell since the beginning of the simulation</td>
<td>Cubic yards/ cell</td>
<td>Cubic meters/ cell</td>
</tr>
<tr>
<td>*.vcx</td>
<td>Total volume change per linear foot at each cell since the beginning of the simulation (.vcc/cell length)</td>
<td>Cubic yards/ linear foot</td>
<td>Cubic meters/linear foot</td>
</tr>
</tbody>
</table>
**REPORT DOCUMENTATION PAGE**

The public reporting burden for this collection of information is estimated to average 1 hour per response, including the time for reviewing instructions, searching existing data sources, gathering and maintaining the data needed, and completing and reviewing the collection of information. Send comments regarding this burden estimate or any other aspect of this collection of information, including suggestions for reducing the burden, to Department of Defense, Washington Headquarters Services, Directorate for Information Operations and Reports (0704-0188), 1215 Jefferson Davis Highway, Suite 1204, Arlington, VA 22202-4302. Respondents should be aware that notwithstanding any other provision of law, no person shall be subject to any penalty for failing to comply with a collection of information if it does not display a currently valid OMB control number. PLEASE DO NOT RETURN YOUR FORM TO THE ABOVE ADDRESS.

<table>
<thead>
<tr>
<th>1. REPORT DATE</th>
<th>March 2015</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. REPORT TYPE</td>
<td>Final</td>
</tr>
<tr>
<td>3. DATES COVERED</td>
<td>(From - To) May 2014 – November 2014</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. TITLE AND SUBTITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>GenCade Version 1 Quick Start Guide: How to start a successful GenCade project</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5a. CONTRACT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>5b. GRANT NUMBER</td>
</tr>
<tr>
<td>5c. PROGRAM ELEMENT NUMBER</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6. AUTHOR(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sophie Munger and Ashley E. Frey</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5d. PROJECT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>5e. TASK NUMBER</td>
</tr>
<tr>
<td>5f. WORK UNIT NUMBER</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coastal and Hydraulics Laboratory</td>
</tr>
<tr>
<td>U.S. Army Engineer Research and Development Center</td>
</tr>
<tr>
<td>3909 Halls Ferry Rd.</td>
</tr>
<tr>
<td>Vicksburg, MS 39180-6199</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8. PERFORMING ORGANIZATION REPORT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERDC/CHL SR-15-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>9. SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10. SPONSOR/MONITOR'S ACRONYM(S)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>11. SPONSOR/MONITOR'S REPORT NUMBER(S)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>12. DISTRIBUTION/AVAILABILITY STATEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved for public release; distribution is unlimited.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13. SUPPLEMENTARY NOTES</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>14. ABSTRACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>This Special Report is a condensed version of previous technical reports describing the shoreline change model GenCade. It is meant to provide new and prospective users of GenCade a starting point to learn the model. While no new topics are presented, important information which would otherwise be distributed among several publications is conveniently grouped in one shore document. The first part of the report describes the basic features of the model and its suitability to a range of applications to help prospective users decide if GenCade is the right tool for a specific project. The second part of the report is a quick start guide with step-by-step instruction on how to build a GenCade project. Each topic presented in this publication is accompanied by a list of references that provide more in depth information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15. SUBJECT TERMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>GenCade</td>
</tr>
<tr>
<td>Shoreline change</td>
</tr>
<tr>
<td>Sand transport</td>
</tr>
<tr>
<td>Surface-water Modeling System</td>
</tr>
<tr>
<td>Model requirements</td>
</tr>
<tr>
<td>Work flow</td>
</tr>
<tr>
<td>User’s guide</td>
</tr>
<tr>
<td>Calibration</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16. SECURITY CLASSIFICATION OF:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. REPORT Unclassified</td>
</tr>
<tr>
<td>b. ABSTRACT Unclassified</td>
</tr>
<tr>
<td>c. THIS PAGE Unclassified</td>
</tr>
<tr>
<td>17. LIMITATION OF ABSTRACT Unclassified</td>
</tr>
<tr>
<td>18. NUMBER OF PAGES 40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19a. NAME OF RESPONSIBLE PERSON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ashley E. Frey</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>19b. TELEPHONE NUMBER (Include area code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>601-634-2006</td>
</tr>
</tbody>
</table>